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1 About MitiConnect

1.1 Preamble

MitiConnect1 is  a  modeling  tool  to  quantifiy  the  impact  of  development  projects  on  ecological
networks connectivity.

1.2 Processing chain

MitiConnect  is  a  QGIS  plugin  designed  as  a  step-by-step  process,  from raw  data  integration  to
scenario comparison. Landscape graph construction is based on Graphab2 . Other processing and the
graphical interface are inspired by BioDispersal3 . Each tab in the graphical interface corresponds to a
step:

1. Definition of general parameters
2. Import data into the tool
3. Definition of target species
4. Definition of friction coefficients
5. Building scenarios
6. Treatment launches for each scenario/target species pair

6.1.Land use constitution
6.2.Friction layer creation
6.3.Graphab project creation
6.4.Link set creation
6.5.Graph creation
6.6.Connectivity metrics computing
6.7.Scenario comparison

1https://github.com/MathieuChailloux/MitiConnect/blob/main/README.md  
2 https://sourcesup.renater.fr/www/graphab/fr/home.html  
3 https://umr-tetis.fr/index.php/fr/productions-fr/outils/biodispersal  
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1.3 Prerequisites

1.3.1 Configuration

MitiConnect runs on any operating system (Linux, Windows, Mac, etc.) with a QGIS version greater
than  or  equal  to  3.16  (https://www.qgis.org/fr/site/forusers/download.html)  and  a  Java  version
greater than or equal to 8 (https://adoptopenjdk.net, preferably the 64-bit version). 

Tests were carried out under QGIS 3.28, Windows 11 and Ubuntu 18.04.1 (bionic).  Under Linux,
installation of the python-gdal package is required. Some features may work without Java. 

MitiConnect is freely available under GPL license.

File and folder names must not contain accents or spaces.

The amount of RAM required for computing depends on the size of the study area, the chosen spatial
resolution and the number of patches per species.

1.3.2 Installation

To install MitiConnect from QGIS, go to 'Plugins'  menu, then 'Install/Manage plugins'. In 'All'  tab,
search for the 'MitiConnect' plugin, select it and press 'Install plugin'.

To install the extension in QGIS from the .zip archive, go to 'Extensions' menu, then 'Install/Manage
plugins', 'Install from zip' and select the downloaded 'MitiConnect.zip' file. 
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Figure 1: MitiConnect processing chain
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Once  succesfully  installed,   icon  appears  in  QGIS  toolbar  and  a  new  MitiConnect  entry  is
available in 'Plugins' menu. If the icon doesn't appear, go to the 'Plugins'  menu, uncheck and then
recheck the line corresponding to MitiConnect.

1.4 Citation

Chailloux M., Tarabon S., Papet G., Amsallem J. & Vanpeene S (2024). MitiConnect: a QGIS plugin to
assess mitigations scenarios impact on an ecological network using landscape graphs

1.5 Graphical interface

Graphical interface is launched from the  icon or from MitiConnect entry in the Plugins menu.
The interface is tab-based, with each tab corresponding to a step in the method.

GUI also contains project management buttons, English/French translation buttons, description of
the current tab and the processing progress bar.

1.6 Project file

We strongly recommend that you regularly save your MitiConnect project settings. These settings
are saved in an XML file.

The project file is managed using following buttons at the top left of the interface: 

Open a MitiConnect project: select an existing project (.xml) and open it.

Create a new project:  enter the workspace folder and the project name to initialize a MitiConnect
project (create output folders and project file).

Save project as: save the project in a new file (.xml) or in an existing file which will be overwritten.

Save project: saves the project in the .xml file already created (projectFile table field).
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Figure 2: MitiConnect project management buttons



1.7 Video tutorials

Video  tutorials  illustrating  step-by-step  use  of  the  tool  are  available  at:
https://www.youtube.com/playlist?list=PLh9oFe6PuPCUC2RQcDhRgl9oGP0tj91sv

1.8 Available data

An inventory and identification of available data ensures that the layers are assembled and that a
synthetic, complete and relevant land use map is produced. 

Various data sources can be used and combined in the background, for instance :

 Cesbio's LUO4 covers all French departments,
 Regional data such as the MLU5 in Ile-de-France, the OCSGE26 in Grand Est...,
 Urban Atlas7 covering all major European metropolitan areas.

These data, complete and homogeneous over large study areas, can (and must) be supplemented by
more precise data available on the whole the French territory:

 BD Topo® from IGN8 ,
 Registre Parcellaire Graphique (RPG)9 , farming parcels register,
 Local inventories of vegetation, wetlands, ponds or other remarkable habitats, etc.

The use of CORINE Land Cover data is strongly discouraged regarding data quality (1/100,000th).

4 https://www.data-terra.org/actualite/produit-theia-oso-2020-nouvelle-carte-doccupation-des-sols/  
5 https://www.institutparisregion.fr/referentiels-geographiques/mode-doccupation-du-sol-mos/  
6 https://ocs.geograndest.fr  
7 https://land.copernicus.eu/local/urban-atlas/urban-atlas-2018?tab=download  
8 https://geoservices.ign.fr/telechargement  
9https://www.data.gouv.fr/fr/datasets/registre-parcellaire-graphique-rpg-contours-des-parcelles-et-ilots-  
culturaux-et-leur-groupe-de-cultures-majoritaire/
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Figure  3: Illustrations of various complete and partial land-
use databases. Taken and modified from Bourgeois (2023) 



2 MitiConnect step by step

2.1 General parameters (tab 1-Parameters)

First step is to define the analysis framework. All parameters must be specified to enable processing.
Workspace folder must be specified before further steps.

Specified parameters are displayed in the bottom table of this tab.

The elements to be filled in are as follows:

 Workspace: folder path in which the project and data outputs will be stored. It is best not to
change workspace during the project.

 Extent layer: represent the study area boundaries. The spatial extent of the study must take
into account the spatial configuration of ecological networks and the maximum dispersal
capacity of species, to avoid any bound effect10 . It is therefore advisable to apply a buffer
area of at least 1.5 × the dispersal capacity of the most mobile species around the project or
its  geographical  variants,  or  even  more  if  the  aim  of  the  study  is  also  to  find  ex-situ
compensation sites. Note that if the study area is underestimated at this stage, the project
and associated modelling should be re-launched.

10 Bound effect  occur  for  spatial  analysises  where  available  data  does  not  cover  the  whole  study  area
(underestimation of the stakes).
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Figure 4: Tab 1 - General settings



 Resolution:  size  of  the  pixels,  expressed in  meters,  for  all  raster  layers  of  the11 project.
Spatial resolution depends on scale and computing capacity. High resolution (low pixel size)
refines the results, but increases computing time and requires greater computing capacity,
especially if the study area is large. Depending on the scale, a resolution of between 5 and 10
m is recommended.

 Projection:  reference coordinate system (default is EPSG:2154 / Lambert 93). The system
must be a metric projection .

2.2 Import land use data (tab 2-Data)

This step is used to import input data and standardize it in raster format with the same resolution
and extent, so that it can be properly aligned.

If you already have a complete land use map, you should still import it at this stage and then proceed
to next step. Alternatively, you can create land use maps directly in MitiConnect by merging several
imports, for instance to take account of linear features (cf. 2.2.3) and species-specific environments.

This tab is divided in several steps:

1. Import land use data

1.1.Set  import  parameters  by pressing or depending  on  layer  format  (vector
or raster).

1.2.Press Import button to start importing. Results are loaded into the Imports group,

2. (Optional) If  needed (see above) create one or more land use layers. 
It may be a good idea to create several land use maps depending on the target species, for 
example distinguishing forest environments only for some of them.

2.1.Press  button and set the layer creation parameters

2.2.Press  button to create layer(s)

3. Check imports  and reclassification parameters  in  Classes  table.  You can change the new
value and add a description.

11 Land use map is produced in raster format. This implies a simplification of reality to a given pixel for
which a single type of environment is associated.
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Figure 5: Land use map at 10m (left) and 50m (right) resolution. The representation of linear
and/or small objects is strongly degraded at 50m resolution. Taken from Clauzel et al., 2020.



2.2.1 Vector data

 Enter import name. Output layer is named after it.

 Select source vector layer.

 (optional)  If  needed, define a  selection  expression. Only matching features in the source
layer will be selected for import. The expression editor on the right helps user to build such
expression.  
For example: "WIDTH" = 'From 0 to 15 meters' for a watercourse

 Define rasterization mode :

◦ By Field value: each unique value of this field will be considered as a specific class. Keep
original values option ensures that reclassification keeps the same values if the field is
numeric.

◦ By Fixed value: all features will be associated with this value

 The all pixels touch option ensures that rasterization does not create artificial discontinuities
for linear data such as roads (see Figure 7).

 The buffer option allows you to apply a buffer area to the input layer before rasterization.
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Figure 6: Tab 2 - Data



2.2.2 Raster data

 Enter import name. Output layer is named after it.

 Select source raster layer.

 Keep original values option ensures that the reclassification keeps the same values.

 Input raster layer is resampled with nearest mode.
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Figure 8: Import raster data

Figure 9: Import vector data

Figure 10: Create new land use layer

Figure 7: all pixels touch option



2.2.3 Create new land use layer

 Enter layer base name.

 Below table contains import names list. If  some imports are missing, press the button to
reload the list. 

 Delete imports not required for current layer creation. Select unwanted imports and press
the delete button.

 Rank imports. Select target import and press arrow buttons to upgrade or downgrade it. 
Output layer is produced by imports merge, according to specified ranking (above import will
erase below ones).
For example, linear features should be placed on top of the land use base layer. To deal with 
roads and watercourses crossings:

◦ For an amphibian, the road (on a bridge or culvert) is not always an obstacle, as the
species can follow the watercourse. In this case, the road network can be placed below
the watercourse;

◦ On the other hand, for other species (land mammals, birds, etc.), individuals will be more
directly affected by the road, which may represent an obstacle. In this case, the road can
be placed above the watercourse.

2.3 Definition of target species (tab 3-Species)

As the analyses based on landscape graphs are species-centric, this third step is to define target
species with their ecological parameters.

To add a species, press the "+" button and enter the following parameters:
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Figure 11: Examples of simplified assembly of land use data from different sources. Taken from
Bourgeois (2023)



 The species identifier and optionally its full name.

 Dispersal  distance.  Maximum  distance  is  the  distance  the  species  can  cover  during
interpopulation exchanges12 . The average distance is more a daily movement. It is easier
here to find bibliography on the maximum dispersal distance of the species 13. If the distance
is expressed in meters, Graphab will translate it into cost units by linear regression. It is also
possible to express this distance directly in cost units to compare 2 scenarios under the same
conditions.

 Land use or import name used for this species (cf 2.2.3)

 Habitat  codes,  i.e.  land-use  categories  as  reclassified  in  step  2,  matching  a  habitat
environment. Matching features will be dissolved to build patch layer.

 Minimum patch size14 for the species to complete all or part of its life cycle. Patches smaller
to  this  size  will  be  excluded.  It  is  a  good practice  to  set  a  minimum value  even  if  this
information is  not  know  to  avoid  isolated  pixels  being  identified  as  nodes  in  ecological
networks.

 Connexity defines the way patches are formed, considering 4 or 8 adjacent pixels to be part
of the same patch.

 By default, coefficients are defined in the 4-Friction tab, but they can also be imported from
an existing layer.

 By default,  the extent is  a buffer area  of 1.5 times the maximum dispersion around the
project extent (see later in Tab 5 - Scenario), but it can also be defined from a layer.

12 Ecological network modeling at the dispersal scale is the most common approach in population viability
analyses.
13 Several metrics include a weighting in their calculation, where distances between patches are converted
into probability of movement. Here, the software takes into account a low p-value (0.05).
14 Patch capacity reflects its "intrinsic quality", considered as an indicator of its demographic potential. Patch
capacity is expressed by its surface area. 
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Figure 12Tab 3 - Species



2.4 Definition of friction values (Tab 4-Friction)

Ecological  network  modeling  using  landscape  graphs  is  based  on  the  notion  of  environmental
permeability, i.e. the ease with which a species can move through an environment.

This permeability is expressed by a numerical value called cost or friction value, which represent the
energy required to pass through the environment. The lower this value, the more permeable the
environment, making it easier to move.

Absolute value of these costs is not important; it's the ratio of proportionality between each friction
class  that  determines that  an environment  A is,  for  example,  5  times more permeable  than an
environment  B.  However,  the  difference  between  classes  must  be  clearly  marked  to  avoid  all
environments to be equivalent for the species.

The numerical values of these costs must be strictly positive integers. If no value is specified, this
land use category will be ignored for the matching species.

Coefficients can be filled in directly in the table, or via a CSV file (spreadsheet) using the buttons at
the top left of the table.

If some values appear to be missing, press the refresh button to reload the entire table.
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SPECIES SELECTION: Given the large number of species that may be affected by a given project, it
is necessary to specify the species for which a quantitative approach to ecological continuities is 
relevant and/or useful. The number of target species depends on the objectives of the study, and 
will not be the same if we are interested in ecological continuities specific to a species with high 
stakes (regulatory, conservation, etc.) or in a broader biodiversity strategy. Several strategies 
exist, and the most common are umbrella, focal and mosaic species (Albert and Chaurand, 2018).
Target species must be sufficiently numerous and complementary considering the environments  
(wooded, open, cultivated, aquatic, etc.), dispersal capacities (low to high) and life-history traits 
(type of reproduction, dispersal strategy, etc.). Species for which we have a good knowledge of 
their ecological requirements (based on bibliography or expert opinion) are preferable, in order 
to be able to fill in friction costs more easily in the next step (tab 4-Friction). Species list should 
also take into account locally available data (collaborative databases: naturalist associations, 
Atlas, INPN, etc.). 



p 15

Figure 13Tab 4 - Friction

FRICTION VALUES There are currently no "standardized" friction values database. INRAE is 
currently working on some guidelines for species selection, with information on dispersal 
distance parameters. However, the results should be treated with caution, as the approach is 
generic and significant variations have been noted between project types and countries studied. 
This work will not be a final result but should serve as an aid, to be thought through according to 
context.
Théma laboratory in Besançon is currently looking into this matter to build a participatory library 
where anyone can present his or her methodological protocol in relation to a given context, 
initial problem, etc. 
In the meantime, a number of bibliographical studies have been carried out to help define costs 
by interpreting biological knowledge in terms of movement capacity in different types of 
environment. These include, for example, the sheets drawn up by the MNHN and the OPIE on 39 
species proposed for the French ecoloigcal network resource center, or those produced by the 
PACA DREAL and Regional Council on the national coherence species present in the region.



2.5 Scenario definition (tab 5-Scenarios)

Scenarios  are  defined  as  land  use  changes  representing  a  stage  of  Avoid-Mitigate-Compensate
sequence (French policy for impact studies):

 Initial state

 Avoidance scenario, e.g. to test different possible extents for a linear transport infrastructure
(LTI) project

 Mitigation scenario, e.g. to test different wildlife crossing locations across an LTI

 Compensation scenario, e.g. to test the installation of new hedges

The initial scenario is already present in the interface. Other scenarios are defined by "stacking", i.e. 
based on an existing scenario.

 To define a new scenario, specify:

 Scenario name of (a short identifier), and if needed a more complete description.

 Base scenario on which the land use changes will be applied

 Scenario layer containing the extent of the land use changes

 Use layer extent option specifies that the study area will be centered around the previous
(land use changes) layer, according to the parameters specified in step 3 for the species
concerned.
If several stacked scenarios use this option, their extents are dissolved.

 Create a long-term scenario option can be used to duplicate scenario in cases where land-
use changes are not the same in the short and long term, typically for compensation actions
where the implanted environments are not functional for several years.
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Figure 14: Create new scenario



 Value reclassification  defines to which land use classes (Code  column in the  Friction  tab /
New value column in the Data tab) are associated scenario layer features.

◦ By field value: unique values of specified numeric field matches land use classes. If these
values do not match land use classes, they can be modified later in the Data tab. 

◦ Fixed value: all features will be reclassified to this value.

2.6 Processing launches (tab 6-Launches)

This last tab lets you manage launches for each scenario and species.

The table is filled in automatically from the other tabs. Each line conntains to a scenario / species /
extent tuple and displays additional information:

 Dispersal capacity computed by Graphab when computing links set, expressed in cost unit.
This capacity must be the same to compare 2 scenarios for a given species.

 Global metrics calculated at the scenario comparison stage

Initial state scenario for a specific species is duplicated for each extent to enable comparison under
the  same  conditions  (extent  and  maximum  dispersal  capacity).  When  a  step  is  launched  for  a
variant/species pair, it is also launched for the species' initial state with variant extent.

Erase existing results overwrites existing results if existing to ensure a clean re-launch.
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Figure 15Tab 6 - Launches



To start launches, select scenarios and species, then press a step button:

1 - Land use: Clips reclassified land use layer to matching extent boundaries

2 - Friction: reclassifies land use to a friction layer according to the Friction tab

3 - Project:  initialization  of  Graphab  project  and  identification  of  patches  (biodiversity
reservoirs)

4 - Linkset: calculates all link sets, i.e. the shortest paths between patches. Each link contains its
metric length and its cumulative cost (friction values sum of the pixels crossed).

5 - Graph: builds landscape graph by keeping
only those links whose cost distance is less
than  maximum  dispersal  capacity.  The
graph represents  patches in  the form of
circles whose size depends on capacity (in
this case, area), and selected links in the
form of segments. The  Components layer
displays  connected  components,  i.e.
interconnected sub-networks.

6 - Spatialize: computes specified local metric
for  patches  and  displays  the  result  as  a
colored legend.

7 - Compare  scenarios:  computes  specified
global  metric  for  each  landscape  graph
and  opens  a  window  with  a  graph
displaying  difference  of  metric  value
between selected variant and initial state,
expressed in percentage.
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METRIC INTERPRETATION: Caution for use: Weighted metrics, whether global or local, take into 
account the distance between habitat patches and their capacity. As their results are rather 
complex to interpret, the values must be interpreted by comparing them to each other (patch X has 
a greater connectivity value than patch Y), and not as a single result (knowing that patch X has an 
Interaction Flow value of 0.8653 doesn't tell us whether this value is strong or weak).

Figure 16: Scenarios comparison
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6 - Spatialize5 - Graph

4 - Linkset3 - Project

1 – Landuse 2 - Friction

Figure 17: Launches results
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